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ABSTRACT 
 

Lo studio che si vuole realizzare in queste pagine riguarda un’analisi approfondita del 

sistema di comunicazione seriale bifilare I2C, si pone il problema del collegamento di più 

periferiche aventi lo stesso indirizzo ad un singolo microcontrollore e mira ad analizzare 

alcuni procedimenti che potrebbero garantire una corretta comunicazione. 

 

Nello specifico sono state sviluppate le seguenti metodologie: 

1. Modifica fisica attraverso saldatura dell'indirizzo del sensore, con cui lo si cambia in 

maniera permanente. 

2. Utilizzare una comunicazione multi-bus. In Arduino, attraverso alcune librerie, è possibile 

rimappare qualsiasi pin di uscita e renderlo una linea dati o clock (indispensabili per avere un 

bus I2C). 

3. Multiplexer I2C. 

4. Hot swapping. 

 

Lo studio è stato condotto utilizzando Arduino Mega, microcontrollore dotato di un singolo 

bus dedicato alla comunicazione I2C, e due Adafruit ICM-20948, sensore IMU a nove gradi di 

libertà. 
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Introduzione 

Da decenni ormai l’elettronica è compagna fedele della nostra quotidianità: automobili, 

smartphones e computer sono solo alcuni esempi di apparati di uso comune che integrano al 

loro interno innumerevoli dispositivi che hanno bisogno di microcontrollori per funzionare. I 

microcontrollori sono progettati per ricevere segnali dall’esterno, interfacciandosi con 

periferiche come sensori, schermi touch screen o altro, elaborarli e fornire un output.  

Bisogna quindi ringraziare i microcontrollori quando due fotocellule (periferiche di input) 

comunicano dei dati ad un processore che li elabora stabilendo se la velocità della nostra 

macchina è oltre il limite (output). 

Data l’enorme diffusione dei microcontrollori è stato necessario standardizzare i protocolli 

che permettessero una comunicazione corretta ed efficiente tra microcontrollori e 

periferiche di produttori diversi. Uno di questi è proprio il bus I2C (Inter Integrated Circuit) 

che, come verrà approfondito in seguito, permette un collegamento relativamente semplice, 

per mezzo di un numero ridottissimo di cavi, solamente 2, ad un numero elevatissimo 

numero di apparecchi come sensori, display o memorie, purché questi abbiano un indirizzo 

unico. 

Per fare un parallelismo, si può immaginare il bus come la via di un centro abitato, il 

microcontrollore come un postino e le abitazioni come le periferiche. Ognuna di queste avrà 

un numero civico (indirizzo) unico e il postino, che deve consegnare una lettera, passa in 

rassegna ogni abitazione in cerca di quella corretta. Cosa succederebbe però, se, per un 

errore inaspettato, due case avessero lo stesso identico indirizzo? Ovvero, cosa 

succederebbe se si volessero interfacciare due periferiche con lo stesso indirizzo alla stessa 

linea I2C? 

Questa tesi vuole risolvere questo problema e vengono analizzate alcune possibili soluzioni 

al problema: 

- Modifica permanente dell’indirizzo in maniera hardware; 

- Utilizzo di due o più bus I2C; 

- Multiplexer I2C; 

- Hot Swapping, cioè alimentare un singolo dispositivo alla volta in modo che non vi 

siano collisioni (solo i dispositivi alimentati possono interagire col bus I2C). 



 

In questa tesi il problema è stato affrontato per i sistemi Arduino, che sono progettati in 

modo da facilitare i collegamenti. 

 

Gli strumenti utilizzati sono stati: 

- Arduino Mega; 

- Adafruit ICM-20948, sensore IMU (Unità di Misura Inerziale) a 9 gradi di libertà; 

- Cavi flessibili per il collegamento tra sensore e microcontrollore; 

- Alimentazione esterna a 5V. 

 

 

Figura 1: Scheda Arduino Mega. 

 

Figura 2: Sensore Adafruit ICM-20948. 



7 

 

Protocollo di comunicazione I2C 

L’Inter Integrated Circuit (I2C) è uno standard per bus di comunicazione seriale sincrona, 

introdotta da Philips nel 1982 e ancora oggi è molto diffuso. Permette in generale il 

collegamento di un microcontrollore (detto master) con un grande numero di periferiche 

(ciascuna è detta slave), oltre 120, utilizzando solamente due linee di trasmissione. Nei 

sistemi più complessi possono essere presenti anche più master o microcontrollori che 

svolgono la funzione di slave.  

 

 

Figura 3: schema connessione periferiche su bus I2C. 

Come si può notare in Figura 3, ogni slave, che si distingue dagli altri attraverso un indirizzo 

di 7 bit, è collegato al master attraverso una linea di dati seriale (SDA) e una linea di clock 

seriale (SCL), in cui la prima serve a trasmettere i bit e la seconda ne determina la frequenza. 

La comunicazione è bidirezionale: questo significa che è possibile, attraverso determinate 

impostazioni, inviare dati dal microcontrollore verso la periferica e viceversa. 

 

Da quando è stato introdotto sono state introdotte varie modalità di funzionamento, che si 

differenziano per le prestazioni. Inizialmente era possibile operare fino a 100kbit/s, poi sono 

state introdotte la modalità Fast, con trasferimento fino a 400kbit/s, la modalità Fast Plus, 

con trasferimento fino a 1Mbit/s e quella Ultra Fast, che permette comunicazioni fino a 

5Mbit/s. 

Il bus opera tipicamente con tensioni di 3.3V o 5V e, per ciascuna linea, sono presenti delle 

resistenze di pull-up per garantire che i livelli logici siano quelli previsti. 



 

 

Figura 4: Schema dei segnali nelle due linee. Le linee tratteggiate blu e rossa indicano rispettivamente le condizioni di start e 

stop e, in particolare, si può notare come queste si verifichino mentre la linea di clock è alta e quella dati in transito. Si 

osservi come le transizioni della linea dati (SDA) si verificano quando la linea di clock (SCL) è bassa. A seguito della 

condizione di start, il microcontrollore trasmette l’indirizzo della periferica con cui comunica (ADDR), il bit di lettura/scrittura 

(R/W) e, dopo aver ricevuto da questa il bit di acknowledgement (ACK) viene trasmesso il messaggio suddiviso in pacchetti 

(DATA). 

Il protocollo prevede il trasferimento dei messaggi suddivisi in pacchetti di 8 bit ciascuno, 

senza limite superiore di pacchetti inviabili. Al seguito della condizione di START, in cui si ha 

la linea di clock alta e la transizione verso il basso della linea dati (visibile in Figura 4), il 

microcontrollore trasmette i 7 bit dell’ADDR con cui vuole connettersi, più un ottavo (R/W) 

che identifica la direzione del trasferimento dei dati, ossia se si vuole scrivere (0) o leggere 

(1). La periferica risponde ponendo a zero la linea dati. I pacchetti successivi contengono il 

messaggio che si vuole inviare. Alla fine di ciascun pacchetto, se non ci sono errori, la 

periferica risponde abbassando la linea dati, come mostrato in corrispondenza del nono bit 

in Figura 4, che corrisponde a inviare un bit, detto di acknowledgement (ACK). La 

comunicazione termina se la linea dati rimane alta (condizione NACK), o se si verifica la 

condizione di STOP, cioè se mentre la SCL è alta si ha una transizione verso l’alto della SDA. 

La scrittura della linea dati viene sempre effettuata (ad eccezione delle condizioni START e 

STOP) durante la fase bassa della linea del clock. 

 

Avendo 7 bit a disposizione, il numero di indirizzi diversi che si possono avere è oltre 100 

(non esattamente 27=128 perché alcuni indirizzi particolari come 00000000 o 11111111 sono 

riservati), un numero decisamente elevato se si pensa al numero di periferiche di cui si può 

aver bisogno. Gli smartphone, ad esempio, interagiscono col mondo esterno attraverso 

pulsanti, antenne, schermi, telecamere, microfoni, altoparlanti e sensori di vario tipo, ma 



9 

 

difficilmente arriveranno a superare le 100 periferiche. In ogni caso, se mai ci fossero 

necessità di questo tipo, esisterebbe una versione più recente del protocollo che opera con 

indirizzi da 10 bit (totale oltre 1000 indirizzi diversi). 

 

La tabella sottostante evidenzia le tempistiche nel caso in cui si stia operando a 400kbit/s. In 

particolare è interessante osservare come i tempi di salita tr e discesa tf non possano 

superare i 300ns ciascuno, mentre il tempo di Setup tSU.DAT, ossia il tempo minimo per il 

quale i dati devono essere stabili prima di poter essere validati, non possa essere inferiore ai 

100ns. 

 

 

 

Tabella 1: Valori prestazionali tipici del bus I2C in modalità Fast, cioè con frequenza di trasmissione fino a 400kbit/s. 



 

Lettura e scrittura nei registri tramite protocollo I2C 

Una volta appreso come operano le due linee di bus, è necessario approfondire come 

avvenga la lettura e la scrittura di messaggi in specifici registri (aree di memoria) della 

periferica. Volendo ad esempio leggere un registro, sarebbe poco efficiente a livello di 

prestazioni e consumi scorrerli tutti quanti di volta in volta fino all’individuazione di quello 

desiderato. Al contrario è molto più conveniente comunicare prima i registri di cui si ha 

bisogno in modo da dover scorrere solamente quelli. 

Nei prossimi paragrafi sarà spiegata come avviene questa comunicazione e, nello specifico, 

come avviene tra Arduino Mega e Adafruit ICM-20948. 

 

1. Scrittura 

Come si può osservare in Figura 5, per scrivere uno o più registri del sensore è necessario 

trasmettere nel bus dati: 

• Il suo indirizzo (AD) più il bit di scrittura (W); 

• L’indirizzo del registro che si vuole modificare (RA); 

• Il messaggio vero e proprio (DATA). 

S e P indicano rispettivamente le condizioni di START e STOP e, come da prassi, dopo ciascun 

byte trasmesso viene ricevuto un bit ACK. 

 

 

Figura 5: lettura di due bytes dal sensore. La prima riga indica quali informazioni sono inviate dal Master nel bus, ossia il bit 

di start S, l’address AD, il bit di scrittura W, l’indirizzo del registro su cui scrivere RA, i dati DATA e il bit di stop P. La seconda, 

invece, indica che il sensore Slave invia nel bus dei bit di acknowledgement ACK. 

 

2. Lettura 

Lo schema per la lettura di uno o più registri all’interno del sensore è riportato in Figura 6. 

 

Figura 6: scrittura di due bytes nel registro RA del sensore. Come per la figura precedente, nella prima riga si evidenzia 

ciascun bit o byte trasmesso da Arduino nel bus, mentre nella seconda riga i dati trasmessi dalla periferica. 
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È necessario quindi: 

• Trasmettere l’indirizzo del sensore (AD) e il bit di scrittura (W); 

• Trasmettere l’indirizzo del primo registro da leggere (RA). 

A questo punto si verifica nuovamente la condizione di START e si dovrà trasmettere 

l’indirizzo del sensore e il bit di lettura (R). Fatto questo sarà finalmente possibile leggere il 

messaggio a partire da RA. 

 

3. Sintassi di Arduino 

L’ambiente di sviluppo di Arduino mette a disposizione dei driver che consentono di gestire 

la comunicazione. Includendo la libreria “Wire.h” sono messe a disposizione alcune funzioni, 

tra cui: 

• begin(): inizializza la libreria Wire; 

• beginTransmission(address): corrisponde a impostare la condizione di START e a 

trasmettere il primo byte, AD+W. address è un numero esprimibile in base 10, 2 o 

16; 

• write(value): viene trasmesso nel bus il messaggio value, già suddiviso per 

pacchetti. Viene utilizzata in seguito a beginTransmission(address); 

• endTransmission(): corrisponde alla condizione di STOP; 

• requestFrom(address, quantity): inizia la trasmissione con la periferica di indirizzo 

address facendo richiesta di leggere un numero quantity di bytes (se la periferica 

non è in grado di inviare abbastanza bytes, la trasmissione termina comunque 

senza dare errori). Corrisponde a impostare la condizione di START e a 

trasmettere il primo byte, AD+R; 

• available() e read(): servono a leggere uno per uno i bytes dopo aver richiamato 

requestFrom(address, quantity). 

Nelle figure 7 e 8 sono riportati dei semplici esempi in cui vengono effettuate operazioni di 

lettura e scrittura. Questi codici di dominio pubblico sono messi a disposizione dall’ambiente 

di sviluppo Arduino IDE (andando su File -> Examples -> Wire) per dimostrare come debba 

essere utilizzata la libreria Wire. 

 



 

I codici contengono varie strutture comuni, ossia l’inclusione della libreria Wire e le funzioni 

setup() e loop() (queste ultime due sono obbligatorie in ogni codice). La funziona setup() è 

richiamata ad inizio esecuzione e, solitamente, vengono inserite istruzioni che devono essere 

eseguite una volta sola. Dopo di essa è richiamata loop() che, come suggerisce il nome, è una 

funzione che viene continuamente richiamata e al suo interno è presente il codice vero e 

proprio. 

 

 

Figura 7: Esempio scrittura da microcontrollore a periferica. Si evidenzino le chiamate alle funzioni 

beginTransmission(address), write(value) e endTransmission() nel blocco loop. 



13 

 

 

Figura 8: Esempio lettura da una periferica. Come si legge dai commenti, la funzione requestFrom(8, 6) richiede la lettura di 

6 bytes dal dispositivo con indirizzo 8, mentre il ciclo while permette di fermarsi qualora non ci siano più bytes da leggere, 

anche se non è stato raggiunto il valore indicato nel secondo campo di requestFrom(address, quantity). 

 

 

 

 

 

 

 

 

 

 

 



 

4. Misurazioni da oscilloscopio 

Volendo assicurare il corretto funzionamento del bus, si è voluto effettuare alcune 

misurazioni con l’oscilloscopio digitale. Utilizzando due sonde passive si è potuto osservare il 

comportamento delle linee di clock (in giallo) e dei dati (in verde). 

 

Di seguito è presente una schematizzazione dei collegamenti tra Arduino, il sensore e 

l’oscilloscopio, in cui in rosso e nero è rappresentata la linea di alimentazione con il relativo 

segnale di massa, in blu il bus I2C e in giallo e verde le due sonde passive (ciascuna con 

riferimento a massa tracciato in nero). 

 

 

Schema 1: Collegamento dell’oscilloscopio al bus I2C mediante sonde passive. 
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Figura 9: in giallo è rappresentata la linea di clock e in verde quella dati. Ciascuna divisione verticale è ampia 5V e ciascuna 

divisione orizzontale 20us. L’evento di trigger individua l’indirizzo 0x69, che è quello di default del sensore studiato. 

 

In Figura 9 è stato impostato come evento di trigger l’individuazione dell’indirizzo del 

sensore e si può notare che: 

- Ciascun segnale è ampio 5 Volt; 

- La condizione di START si verifica con la transizione verso il basso della linea dati e, 

prima di questa, entrambe le linee rimangono alte; 

- La transizione dei bit nella linea SDA si verifica sempre mentre quella SCL è bassa, a 

conferma di quanto riportato in Figura 4; 

- I primi sette bit trasmessi sono l’indirizzo della periferica. Infatti, la sequenza è 

1101001, ossia il numero 69 espresso in formato esadecimale. 

In figura 10 è stato dilatato l’asse dei tempi da 20us a 50us, in modo da includere la 

trasmissione dei primi tre bytes. Si può notare che, dopo aver trasmesso l’indirizzo 0x69, la 

linea dati resta bassa per due cicli di clock, a rappresentare sia l’intenzione di scrivere in un 

registro (ottavo bit basso), sia il bit di acknowledgement (abbassamento della linea dati 

come risposta della periferica). 

 



 

 

Figura 10 

 

La Figura 11 e la Figura 12 mostrano, con scala nell’ordine dei secondi, che il bus è sfruttato 

solamente per lo 0.3% del tempo (3.7ms/1310ms). 

Essendo di 1310ms la distanza temporale tra due misurazioni, si può concludere che è 

presente un ritardo di 310ms, dovuto solo in minima parte alla lettura/scrittura (che è di 

circa 3.7ms). 
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Figura 11 

 

 

Figura 12 

 



 

Collegamento di più periferiche aventi medesimo indirizzo 

Esistono diverse metodologie che permettono di collegare periferiche aventi lo stesso 

indirizzo I2C al medesimo microcontrollore; di seguito ne verranno presentate alcune. 

 

1. Modifica hardware dell’indirizzo 

Quella hardware è sicuramente la metodologia di modifica dell’indirizzo più semplice da 

realizzare, in quanto è l’unica che non richiede la scrittura di alcuna riga di codice. 

Alcuni sensori permettono di manipolarne uno o più bit, tra i sette dell’indirizzo, operando 

su specifici pin. 

Lo schema dei collegamenti è qui riportato; avendo indirizzi diversi, i due sensori possono 

essere alimentati e collegati agli stessi identici pin di Arduino. 

 

Schema 2: Collegamento di due sensori aventi indirizzo diverso al bus I2C. 

 

 

Ad esempio, l’Adafruit ICM-20948 dà la possibilità di portare a massa un pin, chiamato SDO 

(si veda la Figura 2 a pagina 6) e modificare così l’indirizzo da 0x69 (valore di default) a 0x68. 

Infatti, utilizzando il programma di prova “i2c_scanner” (anch’esso di dominio pubblico, 

raggiungibile in Arduino IDE seguendo il percorso File -> Examples -> Wire) si ottiene il 

seguente output: 
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Se da un lato questa soluzione è tanto elegante quanto semplice, dall’altro non sarà mai 

possibile avere una lettura contemporanea dei due sensori poiché il protocollo impedisce il 

dialogo con più periferiche contemporaneamente e si avranno sempre ritardi nell’ordine dei 

millisecondi. Inoltre, nel caso del sensore Adafruit, questa soluzione consente di estendere il 

numero di sensori collegabili al microcontrollore solamente a due. 

 

2. Comunicazione multi-bus 

Non potendo modificare l’indirizzo della periferica, l’unico modo per interfacciare 

contemporaneamente più periferiche è quello di utilizzare più bus I2C. Avendo Arduino 

solamente un bus di questo tipo, è necessario implementare i rimanenti via software. 

 

Schema 3: Collegamento di due sensori con indirizzo identico a due bus I2C differenti. È importante notare che il secondo 

bus, cioè quello implementato via software, non deve necessariamente utilizzare i pin 11 e 13, ma va bene qualsiasi digital 

pin della board. 

 

 



 

Come si può vedere nello schema riportato sopra, l’alimentazione può rimanere la stessa per 

ciascun sensore, mentre le linee bus I2C sono diverse. Nel caso preso in esame, “BUS1” sarà 

l’unica linea progettata da Arduino via hardware, mentre “BUS2” sarà il bus implementato 

via software. 

“SoftwareWire.h” è una libreria scaricabile gratuitamente (in Arduino IDE è sufficiente 

cliccare su Sketch -> Include Library -> Manage Libraries e cercare quella desiderata) e 

permette di rimappare qualsiasi pin come bus dati o bus clock in maniera software; inoltre, 

mette a disposizione funzioni con nomi e comportamenti analoghi a quelli di “Wire.h”. 

L’unica differenza tra le due librerie è la necessità di creare un oggetto di tipo SoftwareWire 

per definire i pin che si vogliono utilizzare. In Figura 13 è riportato un esempio di come 

utilizzare la libreria per impostare inizialmente i pin 13 e 11 della board Arduino Mega 

rispettivamente come linea dati (SDA) e clock (SCL) per il bus I2C. Le istruzioni sono le stesse 

del codice descritto in Figura 8, con la sola differenza di usare la libreria sopracitata al posto 

di “Wire.h”. Nel loop è usata quindi “myWire.requestFrom(8, 6)” per leggere 6 bytes dalla 

periferica avente indirizzo 8. 

 

 

Figura 13: Esempio lettura da una periferica. Esegue le stesse funzioni del codice riportato in figura 8, utilizzando però un 

bus implementato via software. 

Si noti che con l’istruzione “SoftwareWire myWire(pinSDA, pinSCL)” viene data la possibilità 

di utilizzare due qualsiasi digital pin come bus del clock e dei dati, non solamente 11 e 13. 
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Per questioni di compattezza e leggibilità del codice, è fondamentale avere a disposizione 

dei metodi che utilizzino le varie funzioni della libreria Softwire per leggere e scrivere nei 

registri del sensore. 

In Figura 14 è riportato un esempio su come usarle per scrivere all’interno di un registro 

della periferica collegata alla board mediante bus I2C. Per inizializzare la comunicazione 

viene usata la funzione “beginTransmission”, che vuole come argomento l’indirizzo del 

sensore, ricavabile dal data sheet del sensore (0x69 nel nostro caso). Successivamente, per 

scrivere un valore in uno dei registri del sensore, è necessario fornire prima l’indirizzo del 

registro e quindi trasmettere il dato da scrivere (passato tra i parametri). Queste operazioni 

si eseguono utilizzando due volte la funzione “write”. La trasmissione viene conclusa usando 

la funzione “endTransmission”. Infine, viene invocato il metodo “readRegisters(regAddress, 

1)” che, come verrà descritto a breve, andrà a stampare il valore del registro appena 

modificato. 

 

 

Figura 14: Funzione writeRegister. Prende come argomenti l'indirizzo che si vuole modificare e il valore che si vuole inserire e 

stampa il nuovo valore con readRegisters (si veda la Figura 15). 

“readRegisters(regAddress, numberOfRegisters)” è riportato in Figura 15 ed è un esempio di 

codice per leggere il valore di uno o più registri della periferica. Il procedimento è 

esattamente quello riportato nella schematizzazione di Figura 6: dopo aver inizializzato la 

comunicazione, viene utilizzata la funzione “requestFrom” per richiedere la lettura dei 

registri specificati tra i parametri di ingresso. Questi sono il primo registro da leggere 

(regAddress) e il numero di registri da leggere a partire da questo (numberOfRegisters). Si 

noti che ponendo quest’ultimo parametro uguale a 1 si andrà quindi a leggere un singolo 

registro. Successivamente il ciclo while stampa uno per uno tutti i registri, che vengono letti 

con la funzione “read”. 



 

 

Figura 15: Funzione readRegisters. Prende come argomenti il registro da cui si vuole iniziare la lettura e il numero di registri 

che si vogliono leggere. Si noti che ponendo numberOfRegisters = 1 si andrà a leggere un singolo registro. 

 

Come riportato nel data sheet, all’avvio il sensore è in sleep mode e, per poterlo utilizzare, 

bisogna modificare il sesto bit del registro PWR_MGMT_1, di indirizzo 0x06, presente nello 

user bank 0. Questo registro, oltre che gestire la sleep mode, permette anche di reimpostare 

il valore originario dei registri interni, disabilitare il sensore di temperatura e abilitare la 

modalità low power. Come spiegato sopra, è sufficiente scrivere le istruzioni 

“writeRegister(0x7F, 0x00)”, con cui si imposta lo user bank 0 (il valore 0x00 viene inserito 

nel registro 0x7F), e “writeRegister(0x06, 0x01)”, con cui di fatto si modifica solo il sesto bit, 

abbassandolo, poiché gli altri bit hanno gli stessi valori di default. 

A questo punto il sensore è entrato in modalità “acquisizione” e i 14 registri che vanno da 

0x2D a 0x3A sono costantemente aggiornati con le misurazioni di accelerometro, giroscopio 

e termometro. Poiché ciascuna di queste è a 16 bit, si dovranno leggere e manipolare due 

registri alla volta, il primo contenente il byte più significativo e il secondo contenente il byte 

meno significativo dello stesso risultato. Ad esempio, la coordinata x del giroscopio è 

contenuta nei registri 0x33 (parte alta) e 0x34 (parte bassa). 
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Il valore ottenuto dalla lettura, che sarà compreso tra -32768 e +32767, necessita ulteriori 

manipolazioni per essere convertito in un valore espresso secondo la corretta unità di 

misura. Per quanto riguarda la temperatura, ad esempio, vale che: 

temperatura=((lettura-21)/333.87)+21 

 

dove “lettura” è il valore a 16 bit (la formula è stata ricavata dal data sheet). Una 

temperatura esterna di circa 25°C corrisponde quindi a una lettura uguale a 1356. 

Si noti che i registri degli user bank 1, 2 e 3 servono a configurare e testare il sensore e i 

valori di default potrebbero dover essere modificati per un funzionamento ottimale. Con la 

funzione readRegisters è comunque molto semplice confrontare i valori di default con quelli 

impostati automaticamente dai software di test Adafruit (scaricabili da internet). 

 

Di seguito riporto il codice utilizzato (NB: writeRegister e readRegisters si trovano in Figura 

14 e Figura 15 rispettivamente). 

 

 

Figura 16: Dichiaro alcune variabili e costanti. Nota bene che non è necessario utilizzare esattamente i pin 11 e 13 per il bus 

I2C software, ma può andare bene qualsiasi digital pin della board Arduino Mega. 



 

 

Figura 17: Attivazione e configurazione del sensore. 

 

Figura 138: Il loop è composto solo dal richiamo di fullReading e da un delay di 5 secondi. 

 

Figura 19: La funzione fullReading richiama tre volte readRegistersMeasurement, una per ogni misurazione. 
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Figura 20: Modifica di readRegisters per impaginare dignitosamente le letture. La riga 90 unisce due bytes in una halfword 

operando uno shift di 8 bit (che corrisponde a moltiplicare per 256) al byte più significativo e sommandolo a quello meno 

significativo. Le righe da 93 a 96 manipolano le halfword per convertirle in unità di misura del SI. 

Un esempio di lettura è il seguente: 

 

In questo esempio il sensore è fermo e appoggiato su un tavolo. Infatti, il giroscopio riporta 

valori nulli o quasi lungo ciascun asse, mentre l’accelerometro è diverso da zero solo per 

l’asse verticale, nel quale è indicato il coefficiente di gravità terrestre. 

 

3. Multiplexer I2C 

Questa è la soluzione più semplice per risolvere il problema del conflitto di indirizzi se non è 

possibile modificarli e se non è possibile rimappare dei pin. Un multiplexer non è nient’altro 

se non un selettore di linee: c’è un ingresso che va collegato con il bus I2C di Arduino e poi le 

varie uscite vanno collegate a ciascuna periferica. Dal momento che è possibile attivare un 



 

singolo output alla volta, si va di fatto a moltiplicare (solitamente di una potenza di due) il 

numero di linee di bus permettendo di distinguere periferiche con lo stesso indirizzo. 

 

4. Hot Swapping 

Hot swap (o anche hot plug), in informatica, identifica un'interfaccia che permette il 

collegamento e/o lo scollegamento di un dispositivo anche a sistema avviato. 

Se si ha la possibilità di controllare l’alimentazione di ogni periferica in maniera autonoma e 

se non si hanno particolari esigenze prestazionali, l’Hot Swapping può essere una buona 

soluzione. Chiaramente, in questo modo, Arduino sarà in grado di “vedere” una sola 

periferica alla volta. 
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Conclusioni finali 

Le analisi effettuate hanno messo in evidenza come il conflitto di indirizzi nella 

comunicazione tramite protocollo I2C sia un problema risolvibile in diversi modi, che si 

differenziano gli uni dagli altri per costi, complessità, prestazioni e robustezza. 

Sintetizzando ciascuna metodologia: 

 

Modifica hardware dell’indirizzo: è la soluzione senza dubbio più semplice, che permette di 

identificare le periferiche senza dover introdurre altri bus e non richiede alcuna riga di codice 

per la configurazione. Di contro non si possono leggere o scrivere dati contemporaneamente 

(nei limiti della frequenza di clock del microcontrollore, che nel caso di Arduino Mega è di 

16Mhz) su ogni dispositivo, ma solo in sequenza. 

 

Comunicazione multi-bus: la comunicazione multi-bus si può considerare la soluzione 

migliore a livello prestazionale avendo, tra l’altro, un costo trascurabile dovuto solamente al 

cablaggio. Richiede tuttavia l’installazione di librerie esterne, la scrittura di alcune decine di 

righe di codice e uno studio approfondito del data sheet della periferica, poiché non si potrà 

fare affidamento a classi e funzioni sviluppate appositamente dai produttori. 

 

Multiplexer I2C: è una soluzione che, se da un lato è relativamente semplice da interfacciare 

ad Arduino, dall’altro lato aumenta l’asticella del costo come anche il volume fisico 

occupato. 

 

Hot Swapping: probabilmente è la soluzione peggiore, perché necessita di codice per 

selezionare la periferica con cui si vuole interagire e alimentazione separata per ciascuna di 

esse e, inoltre, si possono danneggiare i componenti se non si adottano misure per il 

controllo della tensione (come, ad esempio, le reti di pull-up o pull-down). 

 

Ciascuna metodologia ha quindi i suoi pro e i suoi contro e, a seconda del progetto che si 

vuole realizzare, una sarà preferibile alle altre. Ad esempio, se si volesse realizzare un 

semplice autovelox con due fotocellule, la modifica fisica dell’indirizzo potrebbe essere una 

buona scelta (se fattibile), data anche la poca quantità di bytes da leggere (e quindi la poca 



 

occupazione della linea dati). Se il progetto richiedesse un gran numero di periferiche uguali, 

invece, la scelta migliore ricadrebbe su una comunicazione a multi-bus o, nel caso in cui non 

si avessero a disposizione pin a sufficienza, su un Multiplexer o su un’interfaccia Hot 

Swapping. 
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